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1 Introduction 

The purpose of a document is to convey its content to the reader as simple as 

possible regardless of the reader’s abilities or disabilities. Therefore, it is important to   

ensure that the document can be read and understood by as wide an audience as 

possible. This is the essence of accessibility, and for electronic documents (e-

documents),1 this means making the content of a document accessible to assistive 

technologies such as screen readers, braille reader, magnifiers etc. 

There are several relevant standards as well as national and international 

regulations on accessible Information and Communication Technologies (ICT) 

services, solutions, and digital documents. As national regulations may differ from 

international regulations, the Strategic Advisory Group on Accessibility (SAGA) does 

however encourage to also refer to national regulations. 

Furthermore, to develop an accessible PDF document, it is important that the parent 

document that is supposed to be converted into PDF document is accessible. Most 

documents published as PDFs are first developed in an authoring application such 

as MS Word. The converted PDF then inherits the formatting, labels, and tags etc 

from the authoring application. As MS Word is the most common authoring 

application, the documentation also contains guidelines on how to develop an 

accessible MS Word documents which can lead to an accessible PDF document.  

1.1 Scope 

Many of the same instructions and guidelines apply to different formats of 

documents, but the scope of this document does not allow us to provide guidelines 

to other formats, such as PowerPoint, InDesign and EPUB, or different open-source 

authoring tools, such as Libre Office and Open Office. 

In this guideline document, we will focus on e-documents, more specifically making 

accessible Microsoft Word (MS Word) and Portable Document Format (PDF) 

documents. Chapter 10 – non-web documents of EN 301 549, to which EU’s Web 

Accessibility Directive refers to, is used as a source for accessibility requirements. 

These requirements refer to W3C Web Content Accessibility Guidelines (WCAG) 2.1 

 
1 EN 301 549 V3.2.1 (2021-03) defines “document” as a “logically distinct assembly of content (such 

as a file, set of files, or streamed media) that functions as a single entity rather than a collection, that 

is not part of software and that does not include its own user agent”.  

This definition covers e-documents and “office file documents”, which EU’s Web Accessibility 

Directive (WAD) regulates and defines as “documents that are not intended primarily for use on the 

web and that are included in web pages, such as Adobe Portable Document Format (PDF), Microsoft 

Office documents or their (open source) equivalents”. 
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success criteria on level A and AA. Moreover, the document also includes some 

guidelines based on best practices and recommendations. 

This documentation focuses on how the base document should be developed in 

order to ensure it can be transformed into an accessible PDF. Editing a PDF 

document in an PDF authoring application can be complex and detailed, therefore 

such guidelines are not considered in the scope of this documentation. SAGA 

recommends to rather make the parent document accessible before converting it into 

a new PDF. Chapter 6 of this document does however link to more comprehensive 

information about editing PDFs in Adobe Acrobat Pro. 

NOTE:  

The shortcut keys used in this documentation are based on Microsoft default 

keyboard shortcuts in Word.2 It is possible that the different keyboard layout and 

display language of the Word application have different shortcut keys than the ones 

documented in this document. It is also possible that users of other operating 

systems, such as Macintosh also have different shortcuts layouts. 

1.2 Why Accessible e-documents 

As e-documents contain and convey important information, accessibility of these 

documents is essential to secure equal access, participation, and independence. 

Some documents are essential to take part in a democratic discussion, some to 

understand your rights and obligations, and others to just take part in everyday life. 

Accessible documents are necessary for many groups of users, such as people with 

motor, cognitive and visual disabilities. Moreover, accessible documents can be 

useful for others, such as people with temporary reduced abilities, users without 

disabilities, and users of assistive technologies. Making an e-document accessible is 

therefore the right thing to do so that as many users as possible can benefit from the 

document, regardless of their abilities or disabilities. This is in accordance with best 

practice, as equal access to information is crucial in a democratic society.  

In addition to best practice, accessibility of ICT, including e-documents, have also 

been the object of legal regulations. EU’s WAD regulates for example “office file 

formats” and obliges public sector bodies to make these documents accessible when 

they are available on public sector websites and mobile applications. Moreover, 

many countries have also introduced national regulations on ICT accessibility, 

including e-documents, for both public and private sector. These regulations have 

taken as best practice into a regulatory framework, which again has made 

accessibility an obligation. 

 
2 Microsoft Keyboard shortcuts in Word, retrieved on 20.10.2021   

https://support.microsoft.com/en-us/topic/keyboard-shortcuts-in-word-95ef89dd-7142-4b50-afb2-f762f663ceb2
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2 Things to remember for accessibility of documents 

In order to make it easier to review whether a document meets the accessibility 

requirements or not, we have created a checklist that can be useful to make e-

documents accessible: 

- Step 1: Prepare the structured and formatted document with image 

descriptions (i.e., “alternative text”) in Microsoft Word. 

- Step 2: Use the Accessibility Checker and fix errors, if any. 

- Step 3: Use at least one assistive technology such as NVDA to test the 

reading experience and identify any remaining accessibility barriers. 

- Step 4: When your accessible Word document is ready, save it as PDF if 

required.  

- Step 5: Test the reading order of PDF and ensure the correct tag structure in 

Adobe. 
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3 Creating accessible Microsoft Word documents 

To create an accessible PDF from a Word document, it is important that the Word 

document itself is accessible. If not, the converted file will not be accessible either. 

Editing a PDF later on is much more complex than preparing an accessible Word 

file, which underlines the importance of being thorough when creating the base 

document.   

In order to make the MS Word document accessible, it is important to create a 

logical reading order and structure, with the correct use of elements such as 

headings, lists and tables. Moreover, the text must have sufficient contrast against 

the background, illustrations and images must have a sufficient alternative text etc. 

In the following section, we will guide you through the most relevant features, 

settings etc. necessary to make the MS Word document accessible.     

This document contains stepwise guidelines for mouse navigation, as well as 

keyboard shortcuts, for each requirement. As mentioned above, the shortcut keys 

are based on Microsoft default keyboard shortcuts in MS Word and may vary 

according to the different versions of keyboard layout and display language. 

Here is an example of a shortcut – Press Alt + f, i, i, then select Check 

Accessibility and press Enter. 

Plus (+) requires the user to press and hold the keys before and after 

simultaneously, while comma (,) requires the user to press the following key(s) one 

by one in the given sequence. In other words, the shortcut key above must be 

applied like this: 

1. Press and hold Alt and f simultaneously, 

2. Release Alt and f, and press sequentially I twice, 

3. Choose Check Accessibility from the list, and 

4. Press Enter  
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3.1 Structure and formatting 

A good start is to ensure the document has both a title and a file name that describes 

the purpose of the document. In addition, clear and plain language should be used to 

write the document. Therefore, it is very important to select the correct language of 

the page, this will also help to develop an accessible PDF document when it will be 

converted from Word to a PDF format. 

3.1.1 WCAG success criteria 

- 1.3.1 Info and relationship (Level A) 

- 1.3.2 Meaningful sequence (Level A) 

- 1.4.4 Resize text (Level A) 

- 2.4.2 Page title (Level A) 

- 3.1.1 Language of page (Level A) 

- 3.1.2 Language of parts (Level AA) 

3.1.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision  

- Usage with low vision 

- Usage without vocal capability 

- Usage with limited cognition 

- Usage with limited manipulation or strength 

3.1.3 Stepwise guidelines 

The title of the document is very important for all types of users. The title of a 

document should be easily available to assistive technologies such as screen 

reader. The title should describe the purpose of the document without requiring 

users to read or interpret the contents of the document. File name can be provided 

when creating a document or can also be renamed afterwards. However, it is also 

recommended to provide a title in the properties of the document in addition to file 

name. This will later help in the accessibility of PDF. 

For providing the title of a document in Word, use the following steps. 

Keyboard (title): 

1. Press the Alt + f, i, s, 1 key to add or edit the title of a document. 

Mouse (title): 

1. Select File tab > Info > Under Properties > use Title box to add or edit title of 

a document. 
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3.1.3.1 Language 

Easily understandable language is important for all type of documents. Assistive 

technologies such as screen readers use the language label to select the correct 

speech synthesis. Therefore, it is also important that the document is marked with its 

correct language. In addition, if a document has parts of it such as quotes in another 

language than the default language of the page, then this should also be marked up 

with the actual language of the text.  

For providing correct language info to a document or part of it in Word, use the 

following steps. 

Keyboard (language): 

1. Press the Ctrl + a key to select the whole content of a document. 

a. If you want to select language for a part of a document, such as a 

quote which is in another language than the main language of the 

document. Use Ctrl + Arrow keys to select that specific part. 

2. Press Alt + r, u, l keys and choose the actual language to mark the 

language of a document or part of it. 

Mouse (language): 

1. Select Review tab > under Language > select Language > click on Set 

Proofing Language and choose the actual language to mark the language of 

a document or part of it. 

3.1.3.2 Font and font size 

Font styles are an important aspect of a document which reflect the presentation of 

the content of a document to users. There are no hard and fixed rules about what the 

best fonts for a document are. However, it is important that the given font is easy to 

read for all users, regardless of their abilities.  

Text size of 12 point or higher is recommended, as it will benefit most users. Users 

with sight problems generally find larger text size easier to read.  

For providing font and font size info to the content of a document or part of it in 

Word, use the following steps. 

Keyboard (font and font size): 

1. Press the Ctrl + d key to open the font dialog box. Other shortcut keys: 

a. For selecting font, use Ctrl + Shift + F 

b. For selecting font, use Ctrl + Shift + P 

2. Select actual font, font style, and/or font size. 

Mouse (font and font size): 
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1. Select Home tab > under Font > use Font box to select font and font size. 

3.1.3.3 Headers and footers 

Headers and footers should be formatted using the Header/Footer order, allowing 

users of assisted technologies to distinguish between headers/footers from page 

content. Some assistive technologies may not recognise headers/footers in the Word 

document; therefore, it is important not to include essential information in these 

areas. It is important that a document formatted with headers and footers is 

accessibly designed in Word so that when the document is converted into PDF 

format, then the PDF is accessible for the users, especially for screen reader users. 

Keyboard (heads and footers): 

1. To create a header in your document, press Alt+N, H. 

2. To create a footer, press Alt+N, O. 

3. Insert the text. 

4. Press Alt+J, H, C to exit the header/footer 

Mouse (heads and footers): 

1. Place the cursor at the top or at the bottom of the document 

2. Select the Insert tab 

3. Click Header or Footer in the Header/Footer group 

4. Select a built-in Header/Footer or choose Edit Header or Edit Footer to add 

the corresponding text. 

3.1.3.4 Moving objects 

The structure of a document also includes movable objects, such as a non-text 

object like an image or a text object such as a text box. If these objects are not 

structured correctly, then the reading order of the document can be affected, 

especially for users of assistive technologies such as screen reader users. Select 

“Top and Bottom” or “In Line with Text” for the text for text wrapping around objects. 

This will make it easy for screen reader users to follow the structure of the document 

through the correct reading order. 

For changing text wrapping around movable objects in a document in Word, use the 

following steps. 

Keyboard (wrap text): 

1. Mark the actual object and press Shift + F10. 

2. Select Wrap Text, then select either In Line with Text or Top and Bottom. 

Mouse (wrap text): 

1. Right click on the actual object, select Wrap Text, then click on either In Line 

with Text or Top and Bottom. 
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3.1.3.5 Use of Style 

Pre-defined Styles make it easier to define the structure of your document. Structure 

involves defining the different types of content in your document, such as headings, 

lists, quotes, tables, and columns, while making sure that the formatting is 

consistent, and the document is accessible.  

A style is a set of formatting properties that determine how the content will look, for 

example font type, text size, colour, or shading etc. Applying pre-defined styles gives 

your document a consistent look while also providing important information about the 

content of the document, beyond the visible formatting. This information makes a 

document accessible for assistive technologies, such as screen readers and others, 

who can use styles to navigate through the document if it is formatted using a small 

set of pre-defines styles. 

Style(s) can also be edited, and then all the elements in a document marked with this 

style will undergo the same changes. For example, if a style Heading 1 is defined 

with a font type Arial, text size 16, and colour blue then all Heading 1 in the 

document will have the same formatting.  

In Word, there are different types of styles: 

- Character and paragraph styles: Determine the appearance of the text in a 

document.  

- List styles: Determine the appearance of lists. 

- Table styles: Determine the appearance of tables. 

For applying a style in a document in Word, use the following steps. 

Keyboard (styles): 

1. Place the insertion point in the actual paragraph (paragraph style) or mark text 

to be formatted (character style). 

2. Press Ctrl + Shift + s to open/display the Task Pane for Styles. 

3. Select a style from the list and press Enter.  

4. F6 key can be used for moving between documents, Status bar, Ribbon, and 

Task pane. 

Mouse (styles): 

1. Place the insertion point in the actual paragraph (paragraph style) or mark text 

to be formatted (character style). 

2. Select Home tab > Styles > use Styles.  
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3.2 Headings 

Headings break up text and make content easier to read. When defining a heading, it 

is important that you apply a heading style. Always use heading styles in a logical 

order and do not skip levels. For example, Heading 1 will always be followed by 

Heading 2 and Heading 2 will be followed by Heading 3 or another Heading 2 etc.  

If this is not done, the document will not pass the Accessibility Checker tests. The 

reason is simple: headings are very important, especially for the keyboard users and 

screen readers users, as they use headings to navigate the page by jumping from 

heading to heading. Without headings, it would be almost impossible for these users 

to navigate a page and to understand the content of the document. 

Correct use of heading styles also allows you to create an automatically generated 

table of content, which makes it possible to jump to the right place in the document.  

As mentioned above, headings should have different levels and those levels must be 

correctly nested. Nesting means using different heading levels in a logical order, in 

order to indicate which information is most important and which block is a subset of 

another block.  

Furthermore, screen reader users may think they have missed a heading, or they 

may get confused by the order. And remember, when you are writing headings, keep 

them short, specific to the information that follows them, and clear to someone new 

to the topic. 

If you don’t apply heading styles and instead only change the formatting of the text 

itself, the heading won’t be technically defined as a heading. The appearance may 

provide a consistent structure visually, but the heading will not appear in the 

navigation or in the table of contents. It will also not be interpreted as a heading by 

assistive technology software. 

3.2.1 WCAG success criteria 

- 1.3.1 Info and Relationships (Level A) 

- 2.4.6 Headings and labels (Level AA) 

- 4.1.2 Name, Role, Value (Level A) 

3.2.2 Functional performance statements 

- Users without vision 

- Users with limited vision 

- Users with deaf blindness 

- Users with limited manipulation or strength 

- Users with limited cognition 
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3.2.3 Stepwise guidelines 

It is recommended to keep the Navigation Pane open when a user is applying 

headings or is reading a document. It will help you to confirm the correct heading 

level, the nesting of different headings, and navigation back and forth though the 

headings.  

To view the Navigation pane: 

Keyboard (navigation pane): Press Alt + w, k to open or close Navigation 

pane. 

Mouse (navigation pane): Select View tab > Show > use Navigation Pane. 

Remember that for a normal paragraph text, use the “Normal” from the Styles list in 

Word. For selecting and applying the correct heading level on a paragraph, use the 

following steps. 

Keyboard (headings):  

1. Place the keyboard on a sentence or word that you want to mark as heading. 

2. Press Ctrl + Alt + 1 for Heading level 1. 

3. Press Ctrl + Alt + 2 for Heading level 2. 

4. Press Ctrl + Alt + 3 for Heading level 3. 

5. Press Ctrl + Alt + 4 for Heading level 4. 

6. Press Ctrl + Alt + 5 for Heading level 5. 

7. Press Ctrl + Alt + 6 for Heading level 6. 

8. Press Ctrl + Shift + n to mark the text as a normal paragraph. 

Mouse (headings): 

1. Select Home > Styles > use correct heading level or style.  
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3.3 Page breaks and text splitting 

Most people consciously or unconsciously use the space bar for a large spacing 

instead of Tabs. Several people use Enter instead of page break etc. White spaces 

must be avoided as much as possible in a document. The reason is that they will be 

read out as ‘blank blank blank…’ to someone who uses assistive technologies, such 

as screen reader. Instead, use the Word built-in features such as indentations, line 

spacing, and Styles to achieve the desired visual presentation. 

3.3.1 WCAG success criteria 

- 1.3.2 Meaningful Sequence (Level A) 

3.3.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision 

- Usage with low vision 

- Usage with limited cognition 

3.3.3 Stepwise guidelines 

3.3.3.1 Indentations and inline spacing 

Avoid use of multiple space key for a large spacing in a line or indentation. Use 

Word’s built-in feature “indent” for this purpose.  

Note that indentation and spacing in a line or paragraph are two different ways of 

spacing. An indent or indentation is a space at the beginning of a paragraph. 

However, a spacing can be at the beginning of a paragraph or inside a paragraph or 

line. 

A quick way for a large spacing at the beginning, inside a line or paragraph is to use 

the Tab key which create an indent of 1/2 inches or 9 spaces at font size 12 points if 

no specific tab positions have been set. Press the Shift + Tab key to decrease 

spacing. 

Keyboard (indentation): 

1. Place the insertion point at the paragraph you want to indent or add a large 

spacing. 

2. Press the Ctrl + m key to increase indent or spacing at the beginning of a 

paragraph. 

3. Press the Ctrl + Shift + m key to decrease indent or spacing at the 

beginning of a paragraph. 

Mouse (indentation): 
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1. Select Home tab > Paragraph > Use Increase Indent or Decrease Indent. 

3.3.3.2 Line and paragraph spacing 

Avoid use of Enter key many times to add spacing between lines and paragraphs. 

Instead, use Word’s built-in feature “Line and Paragraph Spacing” for this 

purpose.  

Keyboard (line and paragraph spacing): 

1. Place the insertion point at the line or paragraph 

2. Select Home tab, “Line and Paragraph Spacing” from Paragraph, and then 

“Add Space Before Paragraph” if you want to add space before a 

paragraph. Shortcut keys are as follows: 

a. Add or remove 12 points of space before a paragraph:  Ctrl + 0 

(Zero) or Alt + h, k, select a spacing. 

b. Add Single-spacing: Ctrl + 1 

c. Add 1.5-line spacing: Ctrl + 5 

d. Add Double-spacing: Ctrl + 2 

3. Select Home tab, “Line and Paragraph Spacing” from Paragraph, and then 

“Add Space After Paragraph” if you want to add space before a paragraph. 

Shortcut keys: 

a. Alt + h, k, a.  

Mouse (line and paragraph spacing): 

1. Select Home tab > Paragraph > “Line and Paragraph Spacing” > Use Add 

Space Before Paragraph or Add Space Before Paragraph. Vice versa if 

you want to remove spacing before or after a paragraph. 

NOTE: 

It is recommended to use double or 1.5 spacing between lines to improve readability. 

For long text, use left-aligned instead of justified text. 

3.3.3.3 Page break 

Avoid use of Enter key many times to force a page shift. Use Word’s built-in feature 

“Page Break” for this purpose. 

Keyboard (page break): 

1. Place the insertion point at the line or paragraph you want page shift or page 

break. 

2. Select Insert tab and then select “Page Break” from Pages to add page 

break. Shortcut keys: 

a. Ctrl + Enter.  

Mouse (page break): 
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1. Select Insert tab > Pages > use Page Break 

3.3.3.4 Column shift 

For many users, documents formatted with columns are difficult to read, however 

some layout schemes require this type of formatting. Therefore, it is important that a 

document formatted with columns is accessibly designed in Word so that when the 

document is converted into PDF format, the PDF is accessible for users, especially 

screen reader users. It is best practice to avoid using column split. 

Avoid using the Enter key many times to force a column shift to the beginning of the 

next column on the page. Use Word’s built-in feature “Column Break” for this 

purpose.  

Keyboard (column shift): 

1. Place the insertion point at the line or paragraph you want column shift or 

column break. 

2. Select Layout tab, click “Breaks” from Page Setup, and then select 

“Column” to insert a column break. Shortcut key: 

a. Ctrl + Shift + Enter 

3. A column break is inserted. 

4. Tip: Click Home > Show/Hide (Paragraph mark) to see it. Shortcut key: 

a. Ctrl + ( 

Mouse (column shift): 

1. Select Layout tab > Page Setup > click Breaks > choose Column.  



 

17 
 

3.4 Lists 

Use the List function to create bulleted and numbered lists. Most screen readers 

offer functionality for navigating directly inside lists. The reader will also know how 

many items are in the list. In addition to that, a screen reader also provides 

information regarding where the lists start and ends, and what list item the user is on. 

If the proper list function is not used, then it would be hard for the screen reader to 

properly read the lists. Therefore, it is important to use Word’s built-in list feature in 

Home tab. 

3.4.1 WCAG success criteria 

- 1.3.1 Info and relationships (Level A) 

- 4.1.2 Name, Role, Value (Level AA)  

3.4.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision 

- Usage with low vision 

- Usage with limited cognition 

3.4.3 Stepwise guidelines 

Keyboard (list): 

1. Select the text you want to mark as a list 

2. Press Alt + h to go to the home tab: 

a. For a bulleted list – u. 

b. For a numbered list – n. 

c. For a multilevel list – m. 

3. Select the appropriate list style from the list. 

 

Mouse (list): 

Select Home > Paragraph > choose bullet, numbered, or multilevel list. 
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3.5 Images and illustrations (non-text content) 

Images and illustrations are very important for many user groups. However, images 

that convey a meaning must have an alternative text that describes the purpose of 

the image. This allows users who cannot see the image in the document to 

comprehend its content, nonetheless. 

Decorative Images: Images that do not convey any meaning or content are 

decorative images. These images should not have an alternative text, but rather be 

marked as decorative. 

Groups of images: If multiple images convey a single piece of information, the text 

alternative for one image should convey the information for the entire group. 

Linked Image/Functional image: Images used to provide important functions such 

as navigations are linked or functional images. Functional Images should have the 

alternative text as to describe the function of the image. 

Complex images: Complex images are images that convey a large amount of 

information that can't be structured into a short and concise alt text. Complex 

images should have an alternative text that describes the data and a longdesc or a 

longer alternative that describes the complex image in detail. 

Image of text: Image of text is, as the name suggests, an image of text. This should 

be avoided, if possible, but if used, the alternative text should contain whatever is 

written on the image. 

Advanced Images: Form Image buttons: A form image button is a visual 

representation inside a form. The alternative text should describe what the button will 

do when selected. 

Image maps: An image map is a map of images that together make up a greater 

picture. In these cases, the container of images should have an alt attribute which 

describes the whole image and every image inside the map should have a 

descriptive alt attribute. 

Logos: Logos are a company's branding on a web page or document. Logos should 

have an alternative text that identifies the company, for example the company name. 

To decide in which category, a particular image or illustration fits in, refer to the alt 

Decision Tree (W3C) 

NOTE: 

We recommend to: 

https://www.w3.org/WAI/tutorials/images/decision-tree/
https://www.w3.org/WAI/tutorials/images/decision-tree/
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1. Be accurate in representing content and function. 

2. Add image descriptions to essential images and charts. 

3. Mark non-essential visual elements as decorative 

4. Choose in line wrapping for essential images 

5. Avoid redundancy. 

6. Avoid including phrases like "image of ..." or "graphic of ...". This is redundant 

since screen readers already announce "graphic" along with the alternative 

text. 

3.5.1 WCAG success criteria 

- 1.1.1 Non-text Content (Level A) 

- 1.4.5 Image of Text (Level AA) 

- 1.4.1 Use of colour (Level A) 

- 1.4.3 Contrast (Level AA) 

3.5.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision 

- Usage with low vision 

- Usage with limited cognition 

3.5.3 Stepwise guidelines 

Keyboard (non-text content): 

1. Select the image you want to provide alternative text 

2. Press Shift+F10 

3. Choose Edit Alt Text. 

4. Add appropriate alt-text that describe the purpose of the content of the image. 

a. If the image is a decorative image – Check the checkbox Mark as 

decorative. 

Mouse (non-text content): 

7. Select the image you want to provide an alternative text to 

8. Right click on it and choose Edit Alt Text. 

9. Add appropriate alt-text that describe the purpose of the content of the image. 

a. If the image is a decorative image – Check the checkbox Mark as 

decorative. 
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3.6 Use of Colour 

Colours can be a good tool for conveying meaning, and it is a good idea to use 

colours to give the reader a better overview. At the same time, you cannot use colour 

as the only information bearer, because the abilities to perceive colour vary from 

person to person. 

In diagrams, different colours are often used to convey different information. For all 

sighted users to understand the link between colour and information, other elements 

must also help convey the meaning. For example, different patterns may be used in 

addition to colour. 

3.6.1 WCAG success criteria 

- 1.4.1 Use of colour (Level A) 

3.6.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision  

- Usage with low vision 

3.6.3 Stepwise guidelines 

- If the author uses colour to convey information, it is important to make sure 

that the information is also accompanied by a text alternative. However, the 

best practice is to avoid using colour alone as a mean to convey information. 

- For links, it is a WCAG requirement to NOT use colour alone.  
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3.7 Colour Contrast (Minimum) 

To ensure good readability, the text must have sufficient contrast against the 

background. This also applies to images of text. Regular text should have a contrast 

of at least 4.5:1 (smaller than 14p bold or 24p non-bold). Large text (larger than 14p 

bold or 24p non-bold) should have a contrast of at least 3.0:1. 

3.7.1 WCAG success criteria 

- 1.4.3 Colour Contrast (Level AA) 

3.7.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage with low vision 

- Usage with limited perception of colours 

3.7.3 Stepwise guidelines 

Keyboard (colour contrast): 

1. Press Alt + h to get to the home tab 

2. Press fc, then m to get into the more colours menu. 

3. Navigate to custom colours using the arrows keys 

4. Copy the HEX value 

5. Paste the HEX value into a colour contrast analyser tool such as Color 

Contrast Checker - TPGi 

6. If your colour contrast ratio is less than 3.0:1 then it fails the contrast check, 

then provide an appropriate HEX value that passes. 

Mouse (colour contrast): 

1. Select the text or object you want to check the colour contrast 

2. Select Home > Font colours > More colours > the Custom tab 

3. Copy the colour HEX value 

4. Paste the HEX colour value into a colour contrast analyser tool such as Color 

Contrast Checker - TPGi 

If your colour contrast ratio is less than 3.1:1 then it fails the contrast check, and you 

should provide an appropriate HEX value that passes. 

  

https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
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3.8 Links 

Links should have a descriptive link text, so that it is easy to understand the 

destination of the links included in the document. Either the link text alone, or the link 

text together with the text around it, must clearly describe the purpose and/or 

destination of the link. Many users rely on link text alone. The link text should 

therefore be understandable out of context. For example: 

- Like this: ICT accessibility can be complex. You can find more guidance and 

examples on W3C’s page on PDF techniques for WCAG 2.0.  

- Not like this: ICT accessibility can be complex. For more guidance and 

examples click here. 

It should also be easy for the user to see the links in the document. This means that 

links must be marked using more than just colour. For example, the link text can be 

underlined, or an icon can be associated with the link - but often in combination with 

colour. 

3.8.1 WCAG success criteria 

- 1.4.1 Use of Colour  

- 2.4.4 Link Purpose (in Context) (Level A) 

3.8.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision  

- Usage with low vision 

- Usage with deaf blindness 

- Usage with limited cognition 

- Usage with limited manipulation or strength 

3.8.3 Stepwise guidelines 

Keyboard (Links): 

1. Select the link text or linked image you want to make a link 

2. Press Ctrl + k 

3. Write a link-address in the Address text field. 

4. Write a descriptive link text in the Text to Display text field, then press OK 

button. 

Mouse (Links)  

1. Select the link text or linked image you want to make a link 

2. Right click, click on option Link, and then Insert Link 

https://www.uutilsynet.no/regelverk/lenker/214#beskrivelse
https://www.w3.org/TR/WCAG20-TECHS/pdf
https://www.w3.org/TR/WCAG20-TECHS/pdf
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3. Write a link-address in the Address text field. 

4. Write a descriptive link text in the Text to Display text field, then click on OK 

button.   
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3.9 Tables 

Tables can be challenging for the people who use assistive technology, such as 

screen reader users. Proper use of tables is crucial for the information to be 

interpreted correctly by assistive technology’s users. The more complex the table is, 

for example, a table with merged or split cells and nested tables, empty rows and 

columns, the harder it is to make it accessible. Therefore, you should always 

consider first if it is necessary to present the information as a table. If the answer to 

that question is yes, you must make sure the table is created in the correct way and 

seek to make the table as simple as possible. 

It is recommended to use Word built-in table feature in the insert tab in order to 

create a table in your work. Moreover, the following information must be provided 

appropriately: 

- Table title 

- Table header cells 

3.9.1 WCAG success criteria 

- 1.3.1 Info and relationship (Level A) 

- 4.1.1 Parsing (Level A) 

- 4.1.2 Name, Role, Value (Level A) 

3.9.2 Functional performance statements 

Users with following ability impairments can/may be affected: 

- Usage without vision  

- Usage with low vision 

- Usage with cognitive limitations 

- Usage with deaf blindness 

- Usage with limited manipulation or strength 

3.9.3 Stepwise guidelines 

Keyboard (Tables) 

1. Press Alt + n, t to insert table 

2. Select number of rows and column and press enter. 

3. Press Alt + jt, a to check header row. 

4. Press Alt + jl, o to open table properties. 

5. Navigate to Alt Text tab and add a descriptive title in the Title text field. 

Mouse (Tables) 
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1. Select Insert > Tables > use Table 

2. Select number of rows and column and press enter. 

3. Select Table Design > Table Style Option > check Header Row 

6. Right click on table, select Table Properties, and then navigate to Alt Text 

tab and add a descriptive title in the Title text field. 
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3.10 Interactive forms 

Interactive forms are most commonly used to provide interaction on both websites, 

mobile applications, and documents. Most of the users prefer to use simple and 

short forms. Mostly, the form documents are developed in a way that it is only 

possible to edit in the form fields. Such a type of form document is not optimal and 

accessible for users that use assistive technologies, such as screen readers. It can 

be difficult for them to read the text before, after, or between the form fields. Forms 

developed in HTML or PDF-format words are better than in Word if they are 

designed in an accessible way. In this documentation, guidelines are presented to 

create the most commonly used form elements accessible in Word, which later can 

be converted into accessible PDF format. 

The following things are important to remember when creating interactive forms: 

- Every field needs a descriptive tooltip (same as <label> in HTML).  

- You need to check the tab order in your form.  

- Plan for clear form error messages.  

- Check that all tags are correct. 

It is important to remember here that an interactive form developed in Word does not 

mean that this is a completely accessible interactive form. Therefore, the author 

should test and correct the tags of form elements in PDF authoring tools, such as 

Adobe Acrobat Pro. More information about editing a PDF document in Adobe 

Acrobat Pro is described in Chapter 5.  

It is ideally better to create such documents in formats other than Word and PDF, 

such as HTML, for better accessibility. 

3.10.1 WCAG success criteria 

- 1.3.1 Info and relationship (Level A) 

- 2.4.6 Headings and Labels (Level AA) 

- 3.3.2 Label or Instructions (Level A) 

- 4.1.2 Name, Role, Value (Level A) 

3.10.2 Functional performance statements 

Users with the following ability impairments can/may be affected: 

- Usage without vision  

- Usage with low vision 

- Usage without vocal capability 

- Usage with limited cognition 

- Usage with limited manipulation or strength 
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3.10.3 Stepwise guidelines 

3.10.3.1 Add Developer Tab to Word ribbon 

The Develop tab is used in order to create forms in Word, therefore it needs to be 

added to the ribbon. 

Keyboard (developer tab):  

1. Press Alt + f, t to Word Options. 

2. Select Customize Ribbon 

3. Check the Developer checkbox from the list MainTabs 

Mouse (developer tab):  

1. Select File tab > Options > use Customize Ribbon > Check the Developer 

checkbox from the list Main Tabs. 

3.10.3.2 Add Form Elements 

To develop an accessible interactive form, Word provides several built-in form 

elements. To add a form element to a form, follow the following instructions: 

Keyboard (form elements):  

1. Press Alt + l, n to open Legacy Tools pane, then: 

a. Text Form Field: Press e.  

i. It is important to provide a clear description so that a screen 

reader can read it: In order to add title, select the field press 

Alt + l, e. 

b. Checkbox Form Field: Press h. 

i. Write a good bookmark name under Field setting. 

ii. Click on button Add Help Text, then add a text in the tab Status 

Bar. It should be available to be read out by screen readers. 

c. Label Control: Press a. 

d. Option Button (Radio button) (Design Mode must be activated): Press 

o. 

i. When all Radio Buttons are placed on the form, it is important to 

edit them by right-clicking then choose Option Button Object > 

Edit. 

ii. Provide a GroupName according to the question.  

iii. Deactivate the Design Mode in order to make buttons active. 

Mouse (form elements):  

1. Select Developer tab > Control > use Legacy Tools. 

2. Select a form element such as Text Form Field, Checkbox Form Field, Label 

Control, or Option Button) etc. 
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3.10.3.3 Restrict Editing 

Word’s built-in feature Restrict Editing permits the Word Form to work with assistive 

technology and prevent further changing in the form for an unauthorised person. It 

will also be useful when the form will be converted into a PDF format. 

Keyboard (navigation pane):  

1. Press Alt + l, PE to open or close Restrict Editing pane. 

2. For Forming Restrictions, check the Limit forming to a selection of styles 

checkbox. 

3. For Editing Restrictions, check the Allow only this type of editing in the 

document checkbox, then: 

a. Select No changes (Read only) in the list 

4. Finally, click on button Yes, Start Enforcing Protection. 

5. Enter a Password. 

Mouse (navigation pane):  

1. Click Restrict Editing > check checkbox under, Format Restrictions and 

Editing Restrictions > Select No changes (Read only) in the list > Click 

Yes, Start Enforcing Protection > Enter a Password. 
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3.11 Accessibility Check for Word 

Microsoft provides an Accessibility Checker tool in Word, which is an essential tool 

for ensuring the accessibility of a document. The Accessibility Checker does not 

check for all access issues, but it can help the author discover any obvious 

accessibility issues that can be fixed. Hence, it is recommended running the 

Accessibility Checker and fix the issues (if any).  

The Accessibility Checker distinguishes between three types of feedback. Microsoft 

defined them as Accessibility Checker rules3 and describes them as follows: 

Errors: Content that makes the document difficult or impossible to read and 

understand for people with disabilities. 

Warning: Content that in most (but not all) cases makes the document difficult to 

understand for people with disabilities. 

Tips: Content that people with disabilities can understand, but that could be 

presented in a different way to improve the user’s experience. 

3.11.1 Stepwise guidelines to run the Accessibility Checker 

To run the accessibility Checker, use the following steps: 

Keyboard (Accessibility Checker):  

1. Press Alt + f, i, i, then select Check Accessibility and press Enter. 

2. The Accessibility Checker pane will open, and results will display in task pane 

Accessibility. 

3. Select an issue to display additional information and the instruction to correct 

the issue. 

Mouse (Accessibility Checker):  

1. Select Accessibility from the Status Bar; or 

2. Select File table > Info > select Check for Issues > use Check 

Accessibility 

3. The Accessibility Checker pane will open, and results will display in task pane 

Accessibility.  

4. Select an issue to display additional information and instruction to correct the 

error. 

  

 
3 Microsoft Rules for the Accessibility Checker, retrieved on 21.10.2021   

https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1


 

30 
 

4 Converting from Word to PDF 

In this chapter, the accessible PDF file creation process starting from a Word file is 

described.  

In order to create an accessible PDF file, you must:  

1. Prepare a well-structured document with image descriptions in Microsoft 

Word. 

2. Use the Accessibility Checker and fix errors if any  

3. Use at least one assistive technology such as the open-source screen reader 

NVDA to test the reading order and identify any remaining accessibility 

barriers  

4. When your accessible Word document is ready, save it as PDF.  

To convert documents from Word to PDF, be sure to use the correct settings. There 

are several ways to maintain these settings. Adobe PDFMaker and Word’s built-in 

“Save As” are examples of methods that work correctly. If you use Word’s “Save As” 

feature, it is important that the conversion preserves the properties of the original 

document. 

To make sure Word converts correctly: 

• select “Save As” 

• select PDF file format 

• click the “Options” button 

• select the “Create bookmarks using headings” option 

• select “Document structure tags for accessibility” 

• Uncheck “Convert Comments” if you do not want to keep comments in the 

PDF file. 

When you create the PDF correctly, all content objects are assigned a so-called “tag” 

that defines - either alone or together with a role assignment - how screen readers 

will interpret the objects in the document. This allows screen reader users to 

perceive headings or find their way around a table.  

You can also use the ‘print to PDF’ command. However, this doesn’t preserve the 

accessibility as well. It is therefore recommended to avoid this function. 

4.1 Accessibility checks for PDF 

Depending on how you created the document and which programmes you used 

before converting it to PDF format, some corrections may be necessary. It may be 

necessary to make certain corrections in the base document itself after you discover 
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errors when checking the accessibility of the PDF version in Acrobat Pro. Other 

corrections can be made directly in Acrobat Pro. 

There are several tools and tutorials for checking accessibility. Here are two 

examples that can help you discover the most common errors: 

● Checking the accessibility of the PDFs by Adobe Acrobat Pro 

● Checking the accessibility by European Internet Inclusion Initiative (EIII) 

Just because the document is approved by this type of automatic check does not 

fully guarantee that the document is accessible. There may still be problems that the 

tool is unable to identify. However, this type of tools can be very helpful for finding 

some common problems and correcting them. 

4.2 Test with screen reader 

Testing with screen reader can be done to test the compatibility with assistive 

technology for your accessible PDF documents.  

How to use screen reader 

1. Download the screen reader of your choice. Good alternatives are Jaws, 

Narrator and/or NVDA. 

2. Install the software on your computer. 

3. Start the program, a noticeable prompt will he heard when the program is 

ready to be used. 

4. Minimize the program windows and open the PDF document to test 

5. Turn off your computer screen 

6. Navigate using the shortcuts in and test the criteria in “How to reach the 

minimum requirement 

NOTE:  

This document will focus on NVDA which is one the most used open-source screen 

readers. Since it is limited to Windows systems, users of other operating systems 

can refer to other screen readers, such as JAWS, Narrator or Voice Over. 

4.3 NVDA Shortcuts keys 

4.3.1 General 

You must use the NVDA-modifier key in combination with other keys for some 

keyboard shortcuts. The modification key can be configured. If you are using a 

laptop, it is most likely set to 'CAPS LOCK'. 

Start NVDA: You can start running the program by holding Ctrl + Alt + N keys. 

Stop NVDA: To close NVDA, press NVDA + Q keys. 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
http://checkers.eiii.eu/en/pdfcheck/
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4.3.2 For reading 

- Start reading at the current position: Press NVDA + Down Arrow keys 

- Stop NVDA speech: Press Ctrl key 

- Read the current line again: Press NVDA + Arrow up keys 

- Previous or next word: Press Ctrl + back arrow or forward arrow 

keys 

- Go forward through each page line: Down Arrow key 

- Go backwards through each page line: Arrow up key 

4.3.3 For navigation 

- Navigate forward through the headings: Press ‘H’ key 

- Navigate backwards through the headings: Press SHIFT + ‘H’ keys 

- Navigate forward through heading levels: Press 1 - 6 key 

- Navigate backwards through heading levels: Press SHIFT + 1 - 6 key 

- Navigate forward through links / form elements: Press TAB key 

- Navigate backwards through links / form elements: Press SHIFT + TAB keys 

- Form element: Press ‘F’ key 

- Tables: Press ‘T’ key 

- Buttons: Press ‘B’ key 

- Links: Press ‘K’ key 

- Lists: Press ‘L’ key 

- Items in list: Press ‘I’ key 

- To activate a link: Press ‘Enter’ key 

- To activate a button: Press ‘Enter’ or ‘Space bar’ key 

- Navigate forward through landmarks: Press ‘D’ key 

- Navigate backwards through landmarks: Press SHIFT + ‘D’ keys 

- Switch screen setup mode on / off: Press NVDA + ‘V’ keys 

- Open items list - lists page links, headings, and landmarks: Press NVDA + 

‘F7’ keys 

- Top of page: Press Ctrl + ‘Home’ keys 

- Bottom of page: Press Ctrl + ‘End’ keys 

- Browser address bar: Press Ctrl + ‘L’ keys  
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5 Scanning paper documents to PDF 

Scanned documents initially consist only of a large image. An image of a text is not 

readable for those who use assistive technology like screen readers, magnifiers, or 

tools supporting reading and understanding. For all users to read the content, the 

text must be converted from image into regular text. 

Another thing to consider is that scanned documents are often blurry. Perhaps the 

document is tilted, or it has been scanned and copied several times, making it 

difficult for all users to read. If it is in the form of an image, it will also be impossible 

to search and copy parts of the content.  

5.1 Converting from image to text 

You can convert from image to text using a separate Optical Character Recognition 

(OCR) application that often comes with your scanner, or with the OCR functionality 

in a program such as Adobe Acrobat Pro. Note that regardless of whether you are 

using Acrobat Pro or another application with OCR capability, you will need a PDF 

editor to make the document technically accessible. 

The quality of optical character recognition depends on many factors, including 

image quality and font. Therefore, after using the OCR function, you must first check 

that the result is correct. 

5.2 Structure 

It is important to make sure your content has the right structure. For example, 

headings must be presented as headings so that users who use assistive technology 

can navigate and read the text. You create the right structure by using tags to 

provide the correct reading order. There are various guides and tools such as Adobe 

Acrobat Pro to help you create a good tag structure.  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
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6 Make or Edit a PDF in Adobe Acrobat Pro 

To edit in a PDF, you must have Adobe Acrobat Pro. The free Acrobat Reader is not 

sufficient. There are also other programmes that can edit PDF documents, but we 

have not yet found other programmes that can be used to make them accessible. 

It usually requires some extra work after the conversion for the PDFs to be 

accessible. The amount of work required depends on the type of content in your 

document and the starting point of the base document. 

For some documents, it may be enough to check the order, set the correct language, 

and define how the title should be displayed. To determine exactly what you need to 

do, you may want to check the document.  

The scope of this document does not include the editing of PDF in Adobe Acrobat 

Pro. As it requires extra skills to edit such documents in this program, therefore, we 

only provide information about the useful resource that can be used to edit a PDF 

document in Adobe Acrobat Pro.  

Adobe provides a comprehensive and easy to follow guided workflow required to 

make a PDF accessible – How to create and verify accessible PDFs by Adobe. 

Another solution is to convert the scanned document into Word and use the 

instructions of the current document to turn it into an accessible document. 

  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#make_PDFs_accessible
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7 Extra resources 

The following links provide useful resources that can be helpful when making 

accessible Word and PDF documents: 

⎯ How to make your Microsoft Word document accessible by Microsoft 

⎯ How to create and verify accessible PDFs by Adobe 

⎯ WebAim Document checklist  

https://support.office.com/en-us/article/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ocmsassetID=HA101999993&CorrelationId=9fa8b9e2-0528-49f3-b5a3-d7ddef06b254&ui=en-US&rs=en-US&ad=US
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#make_PDFs_accessible
https://webaim.org/resources/evaloffice/
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https://www.w3.org/TR/WCAG21/


 

37 
 

Annex 1 Comparison keyboard shortcuts 
 

Element Keyboard Windows Keyboard Macintosh 

Access Menu Press and hold Alt and h simultaneously to access 

the menu. 

Release Alt and f, and press sequentially the 

arrows  until you reach the  , 

5. Choose Check Accessibility from the list, 

and Press Enter 

 

Shortcut not available in Macintosh 

3.1. Structure and 

formatting 

  

Title Keyboard (title): 

2. Press the Alt + f, i, s, 1 key to add or edit 

the title of a document. 

 

Shortcut not available in Macintosh 

Language Keyboard (language): 

3. Press the Ctrl + a key to select the whole 

content of a document. 

i. If you want to select language 

for a part of a document, such 

as a quote which is in another 

language than the main 

Shortcut not available in Macintosh 
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language of the document. 

Use Ctrl + Arrow keys to 

select that specific part. 

4. Press Alt + r, u, l key and choose the actual 

language to mark the language of a 

document or part of it. 

Font and font size Keyboard (font and font size): 

 

3. Press the Ctrl + d key to open the font 

dialog box. Other shortcut keys: 

i. For selecting font, use Ctrl + 

Shift + F 

ii. For selecting font, use Ctrl + 

Shift + P 

Select actual font, font style, and/or font size 

 

Keyboard (font and font size): 

 

1. Press the Command + d key to open the 

font dialog box. 

2. Press the Tab to select actual font, font 

style, and/or size. 

3. Use the arrows to determine the values. 

Headers and footers Keyboard (heads and footers): 

 

5. To create a header in your document, press 

Alt+n, h. 

6. To create a footer, press Alt+n, o. 

7. Insert the text. 

Shortcut not available in Macintosh 



 

39 
 

8. Press Alt+j, h, c to exit the header/footer 

 

Moving objects  Keyboard (wrap text): 

 

3. Mark the actual object and press Shift + 

F10. 

4. Select Wrap Text, then select either In Line 

with Text or Top and Bottom. 

Shortcut not available in Macintosh 

Use of style Keyboard (styles): 

 

5. Place the insertion point in the actual 

paragraph (paragraph style) or mark text to 

be formatted (character style). 

6. Press Ctrl + Shift + s to open/display the 

Task Pane for Styles. 

7. Select a style from the list and press Enter.  

8. F6 key can be used for moving between 

documents, Status bar, Ribbon, and Task 

pane. 

Keyboard (styles): 

 

Press Shift+Option+Command+S to 

open/display the Task Pane for Styles. 

9. Select a style from the list and press 

Enter.  

 

3.2. Headings Keyboard (headings):  

9. Place the keyboard on a sentence or word 

that you want to mark as heading. 

Keyboard (headings):  

1. Place the keyboard on a sentence or word 

that you want to mark as heading. 
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10. Press Ctrl + Alt + 1 for Heading level 1. 

11. Press Ctrl + Alt + 2 for Heading level 2. 

12. Press Ctrl + Alt + 3 for Heading level 3. 

 

2. Press Option + Command + 1 for 

Heading level 1. 

3. Press Option + Command + 2 for 

Heading level 2. 

4. Press Option + Command + 3 for 

Heading level 3. 

 

Navigation Pane Keyboard (navigation pane):  

Press Alt + w, k to open or close Navigation pane. 

Shortcut not available in Macintosh 

3.3. Page breaks and text 

splitting 

  

Indentations and line 

spacing 

Keyboard (indentation): 

4. Place the insertion point at the right place of 

the paragraph you want to indent or add a 

large spacing. 

5. Press the Ctrl + m key to increase indent or 

spacing at the beginning of a paragraph. 

6. Press the Ctrl + Shift + m key to decrease 

indent or spacing at the beginning of a 

paragraph. 

Keyboard (indentation): 

 

1. Press Option+Command+m 

2. Press the tab key to move in the different 

fields 

3. Use the arrow keys to determine the value   

Line and paragraph 

spacing 

Keyboard (line and paragraph spacing): Keyboard (line and paragraph spacing): 
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4. Place the insertion point at the line or 

paragraph 

5. Select Home tab, “Line and Paragraph 

Spacing” from Paragraph, and then “Add 

Space Before Paragraph” if you want to 

add space before a paragraph. Shortcut 

keys are as follows: 

a. Add or remove 12 points of space 

before a paragraph:  Ctrl + 0 (Zero) 

or Alt + h, k, select a spacing. 

b. Add Single-spacing: Ctrl + 1 

c. Add 1.5-line spacing: Ctrl + 5 

d. Add Double-spacing: Ctrl + 2 

6. Select Home tab, “Line and Paragraph 

Spacing” from Paragraph, and then “Add 

Space After Paragraph” if you want to add 

space before a paragraph. Shortcut keys: 

a. Alt + h, k, a.  

 

1. Press Option+Command+m 

2. Press the tab key to move in the different 

fields 

3. Use the arrow keys to determine the value   

Page Break  Keyboard (page break): Keyboard (page break): 

Place the insertion point at the line or paragraph 

you want page shift or page break. 
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3. Place the insertion point at the line or 

paragraph you want page shift or page 

break. 

4. Select Insert tab and then select “Page 

Break” from Pages to add page break. 

Shortcut keys: 

a. Ctrl + Enter.  

 

 

Select Insert tab and then select “Page Break” 

from Pages to add page break. Shortcut keys: 

b. Command + Enter.  

Column shift Keyboard (column shift): 

5. Place the insertion point at the line or 

paragraph you want column shift or column 

break. 

6. Select Layout tab, click “Breaks” from 

Page Setup, and then select “Column” to 

insert a column break. Shortcut key: 

a. Ctrl + Shift + Enter 

7. A column break is inserted. 

8. Tip: Click Home > Show/Hide (Paragraph 

mark) to see it. Shortcut key: 

a. Ctrl + ( 

Shortcut not available in Macintosh 

 

3.4. Lists Keyboard (list): Shortcut not available in Macintosh 
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4. Select the text you want to mark as a list 

5. Press Alt + h to go to the home tab: 

a. For a bulleted list – u. 

b. For a numbered list – n. 

c. For a multilevel list – m. 

6. Select the appropriate list style from the list. 

 

 

3.5. Images and 

illustrations (non-text 

content) 

Keyboard (non-text content): 

 

5. Select the image you want to provide 

alternative text 

6. Press Shift+F10 

7. Choose Edit Alt Text. 

8. Add appropriate alt-text that describe the 

purpose of the content of the image. 

a. If the image is a decorative image – 

Check the checkbox Mark as 

decorative. 

 

 

Shortcut not available in Macintosh 
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3.6. /3.7. Use of colour 

Colour contrast 

(Minimum) 

Keyboard (colour contrast) 

7. Press Alt + h to get to the home tab 

8. Press fc, then m to get into the more 

colours menu. 

9. Navigate to custom colours using the arrows 

keys 

10. Copy the HEX value 

11. Paste the HEX value into a colour contrast 

analyser tool such as Color Contrast 

Checker - TPGi 

If your colour contrast ratio is less than 3.0:1 then it 

fails the contrast check, then provide an 

appropriate HEX value that passes. 

Shortcut not available in Macintosh 

3.8. Meaningful links Keyboard (Links): 

 

5. Select the link text or linked image you want 

to make a link 

6. Press Ctrl + k 

7. Write a link-address in the Address text 

field. 

Keyboard (Links): 

 

 

1. Select the link text or linked image you 

want to make a link 

2. Press Command + k 

3. Write a link-address in the Address text 

field. 

https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
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8. Write a descriptive link text in the Text to 

Display text field, then press OK button. 

4. Write a descriptive link text in the Text to 

Display text field, then press OK       

3.9. Tables Keyboard (Tables) 

7. Press Alt + n, t to insert table 

8. Select number of rows and column and 

press enter. 

9. Press Alt + jt, a to check header row. 

10. Press Alt + jl, o to open table properties. 

11. Navigate to Alt Text tab and add a 

descriptive title in the Title text field. 

 

 

Shortcut not available in Macintosh 

3.10. Interactive forms  Keyboard (developer tab) 

4. Press Alt + f, t to Word Options. 

5. Select Customize Ribbon 

6. Check the Developer checkbox from the list 

MainTabs 

 

Shortcut not available in Macintosh 

 Keyboard (form elements):  

2. Press Alt + l, n to open Legacy Tools pane, 

then: 

Shortcut not available in Macintosh 
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a. Text Form Field: Press e.  

i. It is important to provide a 

clear description so that a 

screen reader can read it: In 

order to add title, select the 

field press Alt + l, e. 

b. Checkbox Form Field: Press h. 

i. Write a good bookmark name 

under Field setting. 

ii. Click on button Add Help Text, 

then add a text in the tab 

Status Bar. It should be 

available to be read out by 

screen readers. 

c. Label Control: Press a. 

d. Option Button (Radio button) (Design 

Mode must be activated): Press o. 

i. When all Radio Buttons are 

placed on the form, it is 

important to edit them by right-

clicking then choose Option 

Button Object > Edit. 
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ii. Provide a GroupName 

according to the question.  

iii. Deactivate the Design Mode in 

order to make buttons active. 

 

Restrict editing Keyboard (navigation pane):  

6. Press Alt + l, PE to open or close Restrict 

Editing pane. 

7. For Forming Restrictions, check the Limit 

forming to a selection of styles checkbox. 

8. For Editing Restrictions, check the Allow 

only this type of editing in the document 

checkbox, then: 

a. Select No changes (Read only) in 

the list 

9. Finally, click on button Yes, Start Enforcing 

Protection. 

Enter a Password. 

Shortcut not available in Macintosh 

3.11.  

Accessibility check for 

Word (Accessibility 

Checker) 

Keyboard (Accessibility Checker):  

4. Press Alt + f, i, i, then select Check 

Accessibility and press Enter. 

Shortcut not available in Macintosh 
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5. The Accessibility Checker pane will open, 

and results will display in task pane 

Accessibility. 

6. Select an issue to display additional 

information and the instruction to correct the 

issue. 

 

 

 

 

End of document 


